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Schedules: Beyond the Basics
Michael Massey — Applied Software

AB1712 - If you can model it, you can schedule it. Using schedules in Autodesk® Revit software is a
powerful way of viewing the information in your Building Information Modeling (BIM) projects. Most users
create basic schedules and have a good understanding of how to create schedules. What most users do
not know is some of the more powerful features of schedules. This class will explore some of the lesser-
known aspects of creating schedules, such as creating embedded schedules, using conditional
formatting in schedules, and understanding key schedules. We will also dive into shared and project
parameters and how to use them in calculated formulas.

Learning Objectives
At the end of this class, you will be able to:

e Know when and where to use Key Schedules
e Create an Embedded Schedule
e Know how to use Conditional Formatting in Schedules

e Understand how to work with Parameters in Schedules

About the Speaker
Mike has more than 15 years of experience as an architect working on various types of
projects. He is currently Senior AEC Building Application Specialist at Applied Software, where
he helps firms assess, plan, and implement new technology. His knowledge and enthusiasm
for AutoCAD® products runs deep; he has been a user of AutoCAD since Release 9 and of
AutoCAD Architecture since its debut. He has also developed a deep appreciation for
Autodesk® Revit®. Mike is a contributing author of Autodesk Official Training Courseware and
a repeated speaker at Autodesk University.

mike.massey@asti.com
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Schedules: Beyond the Basics

Introduction

Welcome to this session! | hope you will be able to go Beyond the Basics when using
schedules after this session. Schedules are a power part of Revit. The ‘I” in BIM stands for
information. Schedules are the key to getting to the information.

Creating basic schedules in Revit are pretty simple. | want to discuss some of the lesser known
areas of schedules and show some examples that will improve your ability to retrieve the
information you need.

How to work with Parameters in Schedules

Parameters are the keys to schedules. Revit comes out of the box with many parameters that
can be used to extract information. Of course, not all parameters can be included out of the
box. When the parameter you are looking for is not included, custom parameters or formulas
can be created.

Schedule Properties [ = |
Fields | Filter | Sorting/Grouping I Formatting I Appearance |

Available fields: Scheduled fields (in order):

Assemb - Add —> To Room: Name

Assembly Description pangy
Assembly Name £ _

Comments <--Remove

Construction Type

Cost

Count

Description

Family —

Family and Type Add Parameter...

Finish

Fire Rating - I Caloulated Value... I
Select available fields from:

IDoors - Move Up Mowve Down
[T indude elements in linked files

I Ok I I Cancel I I Help

Formulas

New parameters can be created by using a formula. Formulas allow you to create parameters
that depend on other parameters for their values. Formulas support the following arithmetic
operations: addition, subtraction, multiplication, division, exponentiation, logarithms, and square
roots. Formulas also support the following trigonometric functions: sine, cosine, tangent,
arcsine, arccosine, and arctangent.

Parameter names in formulas are case sensitive. For example, if a parameter name begins with
a capital letter, such as Width, you must enter it in the formula with an initial capital letter. If you
enter it in a formula using lower-case letters instead, for example, width * 2, the software will not
recognize the formula. Itis recommended that you do not use a dash (-) when naming
parameters, because Revit will recognize the dash as an arithmetic operation.
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Inconsistent Units

Typically an error in units will come from breaking the rules required by some operation,
meaning an operator or function. For example:

e Addition requires both inputs, as well as the result, to have the same numerical unit type.

e Multiplication can support any numerical unit type for the inputs, not necessarily the
same, but the result units must be the product of the input units (e.g. length * area =
volume).

e sine() requires the input to be an angle and the output to be a unit less number.

e if() requires the first argument to be Boolean (Yes/No). The other two arguments and
the result can be numerical or not, but they must all be the same.

:'r Revit ) |

o

! Inconsistent Units

By far the most common error when working with formulas is Inconsistent Units. This error is
caused by doing an arithmetic function on two parameters with different units. For example, in
the schedule you already have "Area" and "Cost" but want to add a Calculated Value "Total
Cost". To resolve this error, you will need to get the length value back to a whole number as
opposed to feet. To achieve this, simply divide the length by 1°.

e Area * Cost = Inconsistent Units
e (Area/ 1) * Cost = Total Cost

Another example of an error is trying to multiply two lengths to get a total length. You have to
remember basic algebra. When you multiply a foot value by another foot value you will get a
square foot value, which Revit deciphers as an area. If you want to get a total foot value instead
of an area value, you will need to divide one of the lengths by 1’ to keep the value in feet as
opposed to area. Let's look at the example below.

100 ft * 100 ft = 10,000 ft2

If you have a Length parameter, and try to use a (Length * Length) formula, you’ll get the
“Inconsistent Units" error, because (Length * Length = Length Squared). The only way to
resolve this is to neutralize the units on at least one of the parameters in the formula.
The easiest way to neutralize a unit is to divide by 1 (one):

e 100 ft* (100 ft/ 1 ft) = 10,000 ft

e Therefore 100 ft / 1 ft = 100 (unit less) and 100 ft * 100 = 10,000 ft
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Shared Vs. Family Vs. Project Parameters

There are three types of custom parameters. In a project file, parameters can be either Shared
or Project. In a family file, parameters can be either Shared or Family. We will look at
parameters in a project file first.

In a project file, both shared and project parameters can be added to the project. Both types
can be used to add additional information to the families in the project, and both can be included
in a schedule.

Schedule Properties [ == |

Fields |Fiter | Sorting/Grouping | Formatting | Appearance |

Available fields: Scheduled fields (in order):
Assembly Code

Assembly Description

Assembly Name

Construction Type E
Cost

Count

Description

Family

Family and Type

Function

Head Height

Heat Transfer Coeffident (U) o

Parameter Type

(7) Project parameter

{Can appear in schedules but notin tags)

Add Parameter... (@) Shared parameter

{Can be shared by multiple projects and families, exported to ODBC, and

Calculated Value... appear in schedules and tags)

Select available fields from: Parameter Data

[Dnnrs hd Name:

<No parameter selected> Type
[Tl include elements in linked files
Discipline:

Instance

Type of Parameter:

Group parameter under:

[Dlmenslons V]

[] add to all elements in the category

oK Cancel ] [ Help

Project Parameters

Project parameters are parameters you define and then add to multiple categories of elements
in a project. They are specific to the project and cannot be shared with other projects. You can
then use those project parameters in multi-category or single-category schedules.

To create a project parameter, use the Project Parameter command in the Manage tab.

Click Manage tab > Settings panel > i (Project Parameters).

In the Project Parameters dialog, click Add.

In the Parameter Properties dialog, select Project parameter.

Enter a name for the project parameter.

Select a discipline.

Select the Type of Parameter.

Under Group parameter under, select the heading under which the parameter should
display in the Properties palette or Type Properties dialog.

8. Choose whether the parameter is stored by instance or type.

9. Select the element categories to which you want to apply this parameter.
10. Click OK.

NogkwNRE
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Shared Parameters
Shared parameters are parameters that you can add to families or projects and then share with

other families and projects. They give you the ability to add specific data that is not already
predefined in the family file or the project template.

Shared parameters are particularly useful when you want to create a schedule that displays
various family categories; without a shared parameter, you cannot do this. If you create a
shared parameter and add it to the desired family categories, you can then create a schedule
with these categories. This is called creating a multi-category schedule in Revit.

Shared parameters are stored in a file independent of any family file or Revit project; this allows
you to access the file from different families or projects.

Edit Shared Parameters | P |
Shared parameter file:
C:\Users\mmassey\Documents\ASTI Foa ’ Browse... ] [ Create... ]
Parameter group:
[Doors v]
Parameters:
- . Parameters
Display Frame Fixed Depth -
Display Frame Wrap Around New. ..
Display Type
Display Type FG
Display Type G
Depley Type N
Display Type V
Groups
Parameter Properties l 28 | e N
ew...
Door Frame Depth
Discipling: -
Comman
[ OK ] [ Cancel ] [ Help ]
Type of Parameter:
Length
’ K ] [ Cancel l
Family Parameters

In a family file, there are a number of Revit parameter types.

¢ Shared Parameters can be thought of as user-defined variables.
e System Parameters are variables that are hard-coded in Reuvit.
e Family parameters are variables that are defined when a family is created or modified.
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Created family parameters cannot appear in tags or schedules. Family parameters are used if
the parameter only needs to be seen in the properties of the family. If you need to use the
parameter in a schedule or tag, you must use a shared parameter.

If a parameter is a family parameter and you wish to change it, you can modify it in the Family
types dialog. If you click the Modify button in the Family Types dialog, the Parameter Properties
dialog opens. You can replace a shared parameter with a family parameter or a family
parameter with a shared parameter. Family parameters are specific to one family. You can also
replace one shared parameter with another.

Creating Shared Parameters
You can create shared parameters in the project environment or in the Family Editor. Shared

parameters are saved in a text file; you can then place this file in a shared area on your network
to allow others to access it.

Shared parameters are organized in groups that you create to assist with categorization. For
example, you might create a group called electrical for specific electrical parameters or a
hardware group for specific hardware parameters. You can create as many groups and
parameters as desired.

Edit Shared Parameters S
Shared parameter file:
C:\Users\mmassey\Documents\ASTI\Foa | Browse... ‘ ‘ Create...
Parameter group:
|Dcors - |
Parameters:
- - Parameters
Display Frame Fixed Depth - ———
Display Frame Wrap Around New...
Display Type I
Display Type F E Properties...
Display Type FG
Display Type G ]
Display Type N ILI
Display Type V —
Door Displa Delete
p Groups
Parameter Properties | 2 | =
...
Name: ]
Rename...

Door Frame Depth

Discipline: - IDeI—eteI

Common

| OK | | Cancel ‘ ‘ Help |
Type of Parameter:
| OK | | Cancel ‘

Your session of Revit can reference only one shared parameter file at a time. If there are other
shared parameters in a different file that you want in the active shared parameter file, you need
to export the parameters to the active file.

Typically, most offices will have one master shared parameter file. This file will be shared on
the network with all Revit workstations pointing to the same shared parameter file.
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Special Characters

Revit does not allow for graphics to be included in a schedule. However, Revit does allow for
special characters to be used. Special characters can be used as long as the character is of the
same font style as the font defined in the body font style of the schedule. One example of the

use of special characters would be to create a ‘dot matrix’ type of schedule where you want to
show a special character as the dot.

To set up the schedule to show a special character, three (3) custom parameters will need to be
created. The first needs to be a simple Yes/No parameter; the second two will be created by
using a calculated value.

Creating the Yes/No Parameter

In the Schedule Properties, Field tab, click on the Add parameter button to create the
parameter. Give the parameter a Name and define the Type as Yes/No. This parameter will
be used to initially define whether the special character should or should not be shown. This
parameter will also be used in the calculated value parameters that will be created.

Schedule Properties | 23 |1

S |

Parameter Type

rder):

(@) Project parameter 5

{Can appear in schedules but not in tags)

() Shared parameter

{Can be shared by multiple projects and families, exported to ODBC, and
appear in schedules and tags)

m

Parameter Data

Yes.MNo Type

e
[Common v] (@) Instance

Type of Parameter:

[Yes,fNo v]

3
Integer

MNumber

Length

Area

Volume

Angle

Slope ' [ Cancel ] [ Help

Currency

Mass Density
URL

Material

Yes/Mo

<Family Type... >
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Creating the Graphic Parameter

The next parameter can be created by clicking on the Calculated Value button in the Fields tab
of the Schedule Properties. Prior to creating this parameter, you will need to select your
special character. The easiest way is to open the Windows Character Map. This can be
found by going to the Windows Start button, clicking All Programs, Accessories, and System
Tools. In the Character Map dialog, ensure that the correct font is selected, and browse
through the characters to select the desired character. Once the character is selected; you can
click the Select button and then the Copy button to place the character in the Windows clip
board.

A# Character Map — |7‘:' % |

Font: 0 b -
— C 1 L I -
= N[l w3 [n =] S YA TEFEE A
Y B 1Y AT aC il .
T'ITT—J'L—+‘H'T--'J'LL.J_L[:...:§' o
=—A>v-q<>c-a:.nq©[:-;5ag
vio|r|afa|elt|t|P[RA| ek | Z| 2 O]V
Wiw| % || r|o|= IR
ST | Sy RTINS 7|00 N Yy
AL AN AR AN Al1|T|e||q|2|7|n|1|e|q
olx|plaje(nlilals|a|n|i|l|w|le|]:|e|w]2
U Y Y B I P Iaa I|&la i) s
sld|ld| 25|z zl2l2lzlz|2|2la|z|e=lzl2]| -

Characters to copy | @ Select Copy

[¥] Advanced view

Character set : [Ummde '] Go to Unicode :

Group by : [en -

i
Search for :
U+263A: White Smiling Face L

Once the special character has been copied onto the clip board, you can create the Calculated
Value parameter in the Revit schedule. Give the Parameter a Name (like Graphic), and assign
the Type to be Text. The formula is simply an open quotation mark, the symbol, and closed
guotation mark, similar to the image below.

Calculated Value |.i.|
MName: Graphic
@ Formula () Percentage
Disdpline: lCommon - ]
Type: lText v]
Formula: e E]
CK l [ Cancel l [ Help l
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Creating the If/Then Parameter

The last parameter will be a Calculated Value parameter using an If/Then statement. This will
be the parameter that will display the special character that is defined in the Graphic parameter
if the Yes/No parameter is set to yes.

The If/Then parameter can be created by clicking on the Calculated Value in the Revit
schedule. Give the parameter a Name, assign the Type to Text and type in the following
formula.

if((yes/no parameter name), graphic parameter name, ")

This formula is telling Revit, if the Yes/No parameter is set to yes, then show the Graphic
parameter. If the Yes/No parameter is set to no, then show a blank. The blank is indicated by
the set of quotation marks at the end of the formula with nothing inside of the quotation marks.

Calculated "."alue_A S|

Name: Carpet

Discipline: Commaon

Type: =i

Formula: [ f{{Carpet yn), Graphic, ™| |_|

[ Ok ] | Cancel | | Help |

Once the schedule information is filled out, hide the Yes/No and the Graphic parameter in the
schedule to show only the special character.

Room Finish Schedule
FLOOR FINISH
3
=
Room ‘g- 0| & § S
Number Room Name Area 8 Els|2 8 Comments
Basement
1 Living/Kitchen 470 SF .
2 Dining 194 SF .
3 Guest Bedroom 142 SF .
5 Hot Tub 104SF | e | @
6 Basement 48 SF
7 Closet 110 SF
8 Master Bedroom 260 SF .
25 Mech 51 SF .
27 Storage 48 SF .
28 Closet 17 SF .
34 Bath - DS 95 SF e | o

10
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Editing All Cells

Editing cells in a Revit schedule can be long and monotonous, especially if the majority of the
cells for a parameter are the same though out the schedule. Revit does not allow you to
highlight multiple cells in a schedule to change the value of multiple cells in one step. A tip to
assist in editing multiple cells all at once is to change two properties in the schedule. On the
Sorting /Grouping tab of the Schedule Properties, change the sorting to be sorted by the
parameter that you are trying to change. Then uncheck the ltemize Every Instance check box.
This will collapse all the fields together into one row and you can simply change the value of the
field and it will change it for all items. Then go back and reapply the desired sorting method and
re-check the Itemize Every Instance check box.

a ™

Fields | Filter | Sorting/Grouping |Formatﬁng | Appearance | Embedded Schedule|

Sort by: [Carpet v] (@ Ascending () Descending

[THeader [|Footer: [T Elank line

Then by: [(none} v] (@ Ascending Descending

Header Footer: Blank line

{nong) (@ Ascending Descending

Footer: Blank line

(none) (@ Ascending Descending

Header Footer: Blank line

[ Grand totals:

D Itemize every instance

When and Where to use Key Schedules

Key Schedule

Schedules can be comprised of multiple items that have the same characteristics. For example,
a room schedule might have 100 rooms with the same floor, ceiling, and base finishes. Rather
than enter all this information manually for all 100 rooms in the schedule, you can define keys
that automatically fill in information. If a room has a defined key, then as that room is added to a
schedule, fields in the schedule automatically update, reducing the time required to produce the
schedule.

11
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Setting up the Key Schedule

Keys are defined using key schedules. Key schedules look very similar to component
schedules, except that you define them to your specifications. When you create a key, it is listed
as an instance property for the element. When you apply a value for the key, then the key's
attributes are applied to the element.

N

8.
9

10.
11.

12.

Filter list:  Architecture -

Category: Mame:
Multi-Category> +  Door Style Schedule
Areas (Gross Building)
Areas (Rentable) |E | 71 Schedule building components
Assemblies @ Schedule keys
Casework
Ceilings
Curtain Panels Door Style|
Curtain Systems
Curtain Wall Mullions
Doors
Bectrical Equipment
Electrical Fodures

[ Flogrs

Key name:

| [ cancal

Click View tab » Create panel » Schedules drop-down » B Schedule/Quantities.

In the New Schedule dialog, select the element category for which you want to schedule
keys.

Select Schedule keys.

Revit automatically fills in the Key hame. This is the name that appears among the
element's instance properties. If desired, enter a new name.

Click OK.

In the Schedule Properties dialog, add the predefined fields for the style. For example,
add ceiling finish, floor finish, and wall finish.

Fields or parameters from the selected category can be scheduled using keys.
Additional project parameters can be added to the category and scheduled.

NOTE: Shared parameters cannot be used in a key schedule.

Click OK.

The key schedule opens.

Click Modify Schedule/Quantities tab » Rows panel » = New to add rows to the table.
Each row creates a new value for the key. For example, if you are creating a room key
schedule, you can create key values for executive conference room, small conference
room, large conference room, executive office, standard office, and so on.

Fill in the appropriate information for each of the key values.

12



Scheduling the Keys

To apply the schedule key to a component schedule, simply add the key name of the key
schedule and the associated parameters that are associated with the keys.

1.
2.

3.

Schedules: Beyond the Basics

Create a schedule for the appropriate element (such as a room schedule).

Include in the scheduled fields the key name you created. For example, if you created a
key name called Room Style, add this key to the schedule.

In the schedule, select values for the newly added key. For example, if the key is called
Room Style, you add values for it by selecting them from the menus that appear under
the key heading.

Hoom Finish Key Schedule

Key Hame | Base Finish :

Ceiling Finish i Floor Finish i Wall Finish

Palette A CPT-2 ACT-1 CPT-1 FT-1
Palette B RB-1 ALCT-2 WCT-1 PT-2
Palette C CPT-2 GWB-1 CPT-3 WC-1

Scheduled fields update automatically with the information you define in the key schedule. If you

edit and modify any values in the key schedule, they update automatically in the component

schedule. When you apply a key value to a schedule row, you cannot modify any fields defined
in the key schedule.

How to Create an Embedded Schedule

An Embedded schedule is essentially a schedule inside of another schedule. For example if

you wanted to list all the furniture in each room, you could embed a furniture schedule inside of
a room schedule.

Embedded Room Schedule

Mumber MName Level Area { Department
Mark Famihy and Type Count
101
101 Lobby Level 1 626 SF | General

Chair-Task Arms: Chai: 1

Credenza: 607 x 247

Desk1: 607 x 30" 2

Sofa-Pensi: 657

Table-End: 24" x 247

| paipai el

13
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Available in Room Schedules

Embedded schedules have been available to Revit MEP users for the past several releases.
Revit 2013 brought this capability to architects. In previous releases, when creating a schedule
for spaces, duct systems, piping systems, or electrical circuits, you could create an embedded
schedule to show information about components that are members of these systems. In 2013,
an embedded schedule can be added to schedules for Rooms. Room schedules are the only
architecture category that has the embedded schedule feature.

Embedded Room Schedule |
Number Name Level Area Department|
Type Mark Family and Type i Count
101 Lobby Level 1 626 SF | Admin |
C1 Chair-Task Arms: Chair-Task Arms 1
oy Credenza: 60" x 24" 1
o1 Desk1: 60" x 30" 2 1
51 Sofa-Pensi: 65° 2
T1 Table-End: 24" x 24" 2
T
102 {STAR i Level 1 197 SF { General |
107 CONFERENCE Level 1 283 5F ¢ Admin |
C1 Chair-Task Arms: Chair-Task Arms 8
T2 Table-Ellipse: 727 x 3587 1
9

Room schedules have an additional tab called Embedded Schedule in the Schedule
Properties dialog that other types do not have. To create an embedded schedule, click the
Embedded Schedule tab in the Schedule Properties dialog, click Embedded Schedule,
select a Category, and click the Embedded Schedule Properties button. You can then
configure the embedded schedule properties just like other schedules. Once you have finished
setting up the properties, the fields selected for the embedded schedule appear below each line
in the parent schedule.

Schedule Properties.

| Fields [ Fiter | sorting/Grouping | Formatting | Appearance | Embedded Schedule

Embedded Schedule
Filter list:  <multiple:> -

Category:

Casework -
Curtain Panels

Coars

Electrical Equipment Fields |F|\ber |SurhnngruuD<ng |Furmathr|g|
Electrical Fixtures

m

Furniture Syst Available fields: Scheduled fields {in order):
urniture Systems
Lighting Fixtures B Add > Mark
Mass L4 Assembly Description Family and Type
Mechanical Equipment Assembly Name D Count
Parking
Pipe Accessories
Pipe Fittings
Planting
Plumbina Fixtures S L
Add P: ter...
Embedded Schedule Properties d

Caleulated Value. ..

Select available fields from:

Include elements in linked files

14
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Specifying Room Information in Door Schedules

Another method of combining information from room schedules is to specify the room
information inside a door schedule. You can include information in a door schedule about the
room a door leads to and the room a door leads from. Typically, the door swing indicates the
room the door is leading to or from. For example, in the following image door 56 leads from the
hall to the bedroom.

Bedroom
56 Hall

If you change the door swing after you place the door, this will not automatically be reflected in
the schedule. The schedule retains the data of the initial door placement. Therefore the
particular door opening for door 56, always (by default) leads from the hall to the bedroom
regardless of the door swing. If you want door 56 to lead from the bedroom to the hall, you can
change the door swing in plan view, and then edit the appropriate field in the door schedule.

To configure the room information, on the Fields tab, in the Select available fields from drop-
down, select either From Room or To Room. This will give you a different list of fields to add to
the schedule that are room related. You can select Room Name or Room Number for
example.

Fields |Fi|tEr | Sorting/Grouping I Formatting I Appearantal

Available fields: Scheduled fields (in order):

To Room: Limit Offset - Add —> To Room: Name

To Room: Number To Room: Occupancy
To Room: Pad Cost < Remove

To Room: Program Area

To Room: Tile yn

To Roem: Unbounded Height
To Room: Upper Limit

To Room: Vinyl yn =

To Room: Volume
To Room: Wall Finish

Tooom: ety _ ZEETEEN

Select available fields from:

[To Room
Doors

To Room

][ Cancel ][

15
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Using Conditional Formatting in Schedules

You can use conditional formatting in schedules to visually identify parameters that meet or do
not meet design standards. For example, you can set a condition to indicate that an area has a

square footage under a specified minimum.

Conditional formatting can be created by clicking the Conditional Format button on the
Formatting tab of the Schedule Properties. Select the Field, Test and assign the Value to
create condition. Select a Background Color to show up in the schedule view. The color will

only show up in the schedule view and not on sheets.

Conditional Formatting | = |
Condition
Field: Test: Value:
[Program Percentag v] [Not Between | 90.0% and 110.0%
e e ]I Conditions to Use: Background Color: E
| Fields | Filter | Sorting/Grouping | Formatting 90.0% > Program Percentage or Program Percentage > 110.0% -
ear
Fields:
Number
Name Heafd
Program Area wt
Area i
Area Delta
pea
Department @- oK ] ’ Cancel
Level
Aligrie - 4
[Lef‘t V]
[ caleulate totals
Ok ] [ Cancel ] [ Help
Room Area Schedule - Conditional Formatting
ROOMNO. | ROOMNAME ;| ProgramArea | Area i AreaDelta wt Department Level
107 CONFEREN 300 5F 283 5F -17 5F 94.3% Admin Lewvel 1
101 Lobby 600 SF 6§26 SF 26 5F 104.4% General Level 1
102 STAIR 200 5F 197 SF -3 5F 98.7% General Level 1
110 OFFICE 180 5F 233 5F 53 SF R O-sion Level 1
111 OFFICE A 200 5F 216 SF 16 SF 107.9% Accounting Lewvel 1
112 ‘Women 50 SF 52 SF 2 5F 103.6% General Level 1
113 Electrical 25 5F 14 5F -11 5F General Level 1
114 WMen 50 S5F 42 S5F -8 5F General Lewvel 1
115 Jan 20 5F 205F 0SF 1 O7.5% i General Level 1
Level 1: 9 1625 SF 1682 SF 57 SF
GGrand tntal 9 1825 SF 1RRZ> SF T SF

16
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Other Types of Schedules

Material Schedule
Material schedules list the sub-components or materials of any Revit family. Material schedules
have all the functionality and characteristics of other schedule views, but they allow you to show

more detail about the assembly of a component. Any material that is placed in a component
within Revit can be scheduled.

chedule: Wall Material Takeo

¥ key schedule
il Takeoff =

]| B ™ e

nds | Schedules Sheet Revisions

4 Sheet Composition
&' Schedule/Quantities

—_—1
Lﬁ Graphical Column Schedule

=

a@ Material Takeoff
Sheet List

Mote Block

-

.l

L View List

To create a Material schedule use the Material Schedule tool on the View tab. Material
schedules are similar to component schedules. You must assign at least one Material
parameter in the schedule (for example, Material: Name).

Assigning Cost to Materials

One of the available fields to add to a material schedule is Material: Cost. This is a field that
you can assign a dollar value for the cost of Material. The Material: Cost parameter is stored
in the Material Library. You can create additional materials with different cost values. Cost
values can be used to create a material cost schedule.

Materal Bowser - inishes - Interior - Gypsum Wall 2. g | oteriel gt T
|
=
Neme
u Fabric
B rones - toon - scouste g Tie 20 x88
[ [ o—
Fisshes - Iteror - Gypsum Wall Board
Type | Paint/Costing
Wl e e i e
. G Product Infarmation
Manafactarer
= Model
=
Cost | 3089
Jwodies Name
Autodesk Materiah [F0 o
it Bl s
‘e
°e-Q@ Revit Annotation Information
o ) comal ¥enote
Mark
Assets (=
Nome Aspect
Q- =
Custon Pacameters oone
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Calculating Cost Totals

Schedules: Beyond the Basics

If you desire a material cost schedule, you will need to calculate the cost of the materials by the
area of the material. This can be accomplished by creating a new Calculated Value parameter.
You will need to remember to divide the Material: Area by 1’ to get the units back to whole

numbers.

To get the schedule to properly show the total values, you will need to check the Grand Totals
check box, and uncheck the Itemize Every Instance check box on the Sorting/Group tab. On
the Formatting tab check the Calculate Totals check box for the Material: Area and the Total

Material parameters.

_ Sorting/Grouping | Formatting | Appearance
Sort by: [Material: Name v] @) Ascending () Descending
[ Header [|Foater: [ Blank line
Then by ’(none} v] @ Ascending Descending
none) @ Ascending Descending
none) (@ Ascending Descending
Grand totals: Totals anly - ]
|:| Itemize every instance
[ OK ] [ Cancel ] ’ Help

Wall Material Takeoff
Material Area Zost/ 5F  |Total Materail Caost
Fabric 2 121 5F $0.99 §119.82
Finishes - Interior - Gypsum Wall Board a0a6 5F §1.23 Fa809 24
Gypsum VWall Board 326 5F F1.20 §3490.86
Insulation § Therrmal Barriers - Rigid 452 5F 5075 $713.66
ingulation
Masonry - Brick 4383 5F §3.84 F16832.40
mMasonry - Concrete Masanry Units 1714 5F $3.00 $5142.40
Metal - Furring 1660 SF §6.00 F9961.75
Metal - Stud Layer 5030 5F $6.00 $30178.93
Yapor fWoisture Barriers - Damp-proofing 930 5F $0.29 F§362.52
Vapar f Moisture Barriers - Vapor Retarder 3509 5F F0.40 F1403.70
Wood - Sheathing - plywood 34745 5F F0.95 F3301.61
30156 5F §78316.89
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Schedules: Beyond the Basics

Creating a Note Block Schedule
A Note Block can be used to create a numbered list of notes in your project.

The Note Block tool creates a unique kind of schedule that reads the parameters for a generic
annotation family. The annotation family is placed into the project and populated with the
information you want to track. The note block will sort and arrange the information that has
been placed in the generic annotation elements.

Maote Block
Tag Text
A, Zeneric Roof
C Zeneric Window
B Generic YWall
O zeneric Door
L — — — , . Level 2
| | 10‘ _ UII
O—+
- Level 1
o -0
] South
/8" =1-0"

It is important to understand that the note block element is reading parameters assigned to the
annotation element and not any other elements in the Revit model. In order to make a change,
the annotation element properties must be changed.
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Schedules: Beyond the Basics

Creating an Annotation Symbol
Revit does not come with an Annotation Symbol that can be used when creating a note block.
A new Annotation Symbol family must be created prior to creating the note block schedule.

The following steps outline how to create the Annotation Symbol family.

Click @ > New »£5 (Annotation Symbol).

In the New Annotation Symbol dialog, select the Annotation Symbol template for the

project, and click Open.

The templates are all very similar. Some may already have predefined properties and

values.

Revit opens the Family Editor.

Click Create tab » Properties panel » 25 (Family Category and Parameters).

Click Create tab » Text panel > B (Label).

In the Type Selector, select the label type.

Select the vertical and horizontal justification.

In the drawing area, click to position the label.

e For example, in a generic model tag template, place the cursor at the intersection of
the 2 reference planes.

10. Click the New Parameter to create parameter to add to the label.

11. Create a new parameter (named Number).

12. In the Edit Label dialog, under Category Parameters, select the parameter you want in

N

w

©CoOoNo oA

the label, and click - to add the parameter to the label.

13. Click OK.

14. To modify the placement of the label, click Modify, select the label, and then drag it to
the new location.

|
: E ters to 2dd to the label, Parameters will be combined into 2 single lsbel.
| Enter sample values ta represent this label in the family environment. [ wrap between parameters only
I Category Parameters Label Parameters
! Momber ] Parameter Name | Spaces |  Prefix Sample Value Suffic | Break
|
1 [ Number 1 XK
! 5
|
|
|
|
|
|
|
|
|
|
|
| hEn
|
|
|
|
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Using View Schedules
View schedules are schedules that can be used internally to help manage the views inside the
Revit project. Managing views are critical to ensure that the correct views are being used on the

sheets and that the views are graphically showing what is intended. View schedules will

Schedules: Beyond the Basics

probably never be placed on a sheet to be plotted, but it is a great tool to use throughout the

duration of the project. It provides a single view listing all the views and items such as level of

detail, scale, and sheet information.

Wiew List
H Sheset Phasing

Use Name Level Deetail Scalei No. Name Title Phasze Filter
Documentation
Ceiling Plan: Ceiling Plan
Doc tati | Level 1 | Level1 |Coarse 48 | A2 FirstFloor Reflected | I New Construction | Show All |
Doc tati ilevel 2 i Level2 :Coarse 96 i Mew Construction Show All |
Elevation: Building Elevation
Doc tati East Coarse 56 A5 Elevations New Construction Show All
Doc tati North Coarse 96 Ad i Elevations New Construction Show All
Doc tati South Coarse 96 Ad i Elevations New Construction Show All
Doc tati West Coarse 56 AS i Elevations New Construction Show All
Elevation: Interior Elevation
Doc tati Elevation 1-a Coarse 24 A1t Interior Elevations New Construction Show All
Doc tati Elevation 1-c Coarse 24 A11 ¢ Interior Elevations New Construction Show All
Doc tati Elevation 1-d Coarse 24 A11 ¢ Interior Elevations New Construction Show All
Doc tati Elevation 2-a Coarse 24 A11 i Interior Elevations New Construction Show All
Floor Plan: Floor Plan
Doc tati Level 1 Level 1 : Coarse 48 A1 i First Floor New Construction Show All
Doc tati Level 2 Level 2 | Coarse 48 New Construction Show All
Doc tati Roof Roof : Coarse 48 A3 i RoofPlan New Construction Show All
Doc tati Site Roof : Coarse 120 C1 i Site Plan New Construction Show All
Rendering: Rendering
Doc i | Cover Rendering 1 AD | Cover Shest |
Section: Building Section
Doc tati | Section 1 Fine 48 | A8 | Buiding Sections { New Construction | Show All |
Doc tati i Section 2 Fine 48 | AB | Building Sections i Mew Construction Show All |
Section: Wall Section
Doc tati Callout of Section 1 Mediu 24 A8 Wall Sections New Construction Show All
Doc tati Callout of Section 2 Mediu 24 A8 Wall Sections New Construction Show All
Doc tati Section 3 Fine 24 A8 i Wall Sections New Construction Show All
Working
30 View: 3D View
‘Working 30 View 1 Mediu New Construction Show All
Working Cover Mediu New Construction Show All
‘Working Realistic Mediu 96 MNew Construction Show All
Working Sun Study Mediu 95 New Construction Show All
Working {30} Mediu 95 New Construction Show All
Rendering: Rendering
‘Working Conference_1 1
Working Cover Rendering w/ Backgroun 1
Working Lobby 1
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Exporting/Importing Schedules

Schedules: Beyond the Basics

Typical schedules that are used on every project should be created in the Revit Template file.
This will allow them to be available in all projects started with the template file. Schedules that
are used occasionally should be saved and stored in a ‘Master’ schedule file. This file is an
empty project file on the network that is accessible by all users. Schedules can either be saved
to a new file or inserted from another project to create this ‘Master’ schedule file.

Saving to a Revit File

To save a schedule out to a new Revit file, simply Right Click on the schedule name in the
Project Browser and click Save to a New File. This will export the schedule and all custom
parameters used in the schedule to a new file.

View Template

{ <MNonex>

"Phasing
Phase Filter

Fields

Arch White Box 2012
+-- Elevations |
4 Sections (B
4 Sections (W
+-- Renderings

+ Legends

=8 Schedules/(

Open

Close
Make Workset Editable

Apply Template Properties...

Create View Template From View...

Duplicate View

Convert to independent view
Apply Dependent Views...
Save to Project as Image...
Delete

Copy to Clipboard
Rename...

Select All Instances
Properties
Save to New File...

Search...

MNote Block

Inserting a View from another

Room Finish Schedule
Room Schedule

m

w

If you need to import a schedule from one file to another, you can use the Insert from File,
Insert Views from File tool on the Insert tab. This will allow you to browse to find the file that
you are inserting the schedule from. Once the file is selected, you will see a list of all the
available views to insert. Select the schedules to insert and click OK. This is a great way to
insert schedules from a ‘Master’ schedule file.
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Exporting to Excel

Views:

[Shuw all views and sheets -

[]5chedule: Carpet Room Finish Schedule
[¥]5chedule: Cot Matrix Schedule

[#]5chedule: Drawing List

[C]5chedule: Embedded Roam Schedule
[C]5chedule: Room Area Schedule - Conditional Fi
[~ |5chedule: Room Finish Key Schedule
[]5chedule: Room Finish Schedule

[l schedule: View List - Combined

[C]Schedule: View List - Use + Plan Type

[ cnedal | [ checkhone

Preview selection

Select drafting views, schedules, or reports to be added to the current project.

Preview:

Schedules: Beyond the Basics

Revit has the ability to export schedules to a .txt - comma delaminated file that can be opened
in Excel. This is a one-way export, meaning once exported the .txt file will not be updated if the
data changes in the Revit file, and if the .txt file is updated the Reuvit file will not be updated.

The export tool is found under the Application Menu (the big R). In the Application Menu,
scroll down to Export, Reports, Schedules.

[ e

»

»

Mzﬂagvmvwv =- 7 0 A @-0 %

Creates exchange files and sets options.

7 Exports an ADSK exchanage file,

= FBX
Saves a3D view as an FBX file.

[ Famiy Types
= Exports family types from the current
family to a text (e file,

Baly goxmL
S | Saves the project as a gbXMLfile.

Mass Model gbXM|

L
{ U Saves the conceptual energy model asa
£

abXML file,

IFC
2

Saves an IFC file.
ODBC Database
B Saves model data to an ODBC
ase.

Images and Animations
LT e mage e,

Walll
Jiaterial

3

IS “nierior - Gypsum Wal Board
InWall Board

on / Thermal Barriers - Rigid nsulatin
B

% Reports D
Saves a schedule or Room/Area report,

% Options
Sets export options for CAD and IFC, "

[T]Schedule
Room/Area Report
B P

T SCneaUies/ Quant
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Conclusion

With the technology of Revit we are able to provide more information to the contractors than
ever before. This added information helps provide a better all-around project. Schedules are a
vital part of documentation. Understanding how to retrieve the data in the Revit models will
ensure that projects are coordinated and accurate. The data is stored in parameters.
Parameters are needed both on a project level and an office wide level. Custom parameters are
needed along with calculated value parameters. The topics covered in this session will give you
an infinite supply of knowledge to create the schedules needed for your next project.

In addition to creating schedules for documentation, schedules should be used throughout the
project to assist in meeting design requirements. Take advantage of Conditional Formatting
to see where the design is not meeting the requirements.

| want to thank you for attending my session Schedules: Beyond the Basics. | hope this session
has brought you to a knowledge level that you feel comfortable creating parameters, formulas,
and schedules to meet your project needs.
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